Overview
Thank you for downloading Multimedia Manager!

Multimedia Manager is an all in one multimedia software that lets you view image files,
play audio files, and manage your files easily. It supports many popular multimedia
formats: BMP, JPG, GIF (including animated GIF), TIF, TGA, PNG, PCX, WMF, PCD,
ICO, MID, WAV, RMI, AVI, MOV, MPG, DAT, ANI, and CUR.

Includes these features: REAL drag'n drop support, slide show feature, wallpaper
support, batch conversion, list box feature, advanced image manipulation support, and
other cool and unique features.

You can browse this help file with the {button <<,Prev()} and {button >> Next()}
buttons on the toolbar. Of course you can also use {button Contents,Contents()} and
{button Index,HelpOn()} to get quickly to the topic of interest.



Features
Features

¢ Built-in graphics viewer
Supported formats: BMP, JPG, GIF (including animated GIF), TIF, TGA, PNG, PCX, WMF, PCD, and
ICO. FAST image decoding, BEST image quality, and support image dithering for true color image in 16
or 256 color resolution.You can stretch, tile, flip, rotate, resize or zoom image easily. Since version 1.3a,
you may print or scan image as well. Mgt

o Built-in audio and video player
Supported formats: MID, WAV, RMI, AVI, MOV, MPG and DAT.
MOV, MPG and DAT file require properly installed MCI drivers to play.

e Support cursor file (ANl and CUR)
¢ Clipboard support to copy image to clipboard or paste image from clipboard

o User friendly interface that help you to manage files easily
It is designed to be easy to use for novice users and also to be efficient and flexible for experienced
users.

e Can convert images to BMP, JPG, GIF, PNG, PCX, TIF, and TGA
Save resolution: monochrome, 16 color, 256 color, true color, or JPEG grayscale.
Supported TIFF compression method: CCITT, FAXCCITT3, FAXCCITT4, LZW or PACKBITS.
Support JPEG smoothing and interlaced PNG.

¢ Advanced slide show feature
You can choose to run slide show whether in manual or automatic mode. Also you may display pictures
in random order.

¢ Support to configure desktop wallpaper HOT
And moreover you can use any graphics file supported by Multimedia Manager as desktop
wallpaper. Multimedia Manager will handle the conversion problem for you.

. Full DDE support
¢ Easy installation and uninstallation

¢ and other useful and handy features...

Plus these powerful features

¢ Advanced image manipulation feature o

Since version 1.2a, you can add special effects and filters to manipulate image (bleed, blur,
border fade, dark, sharpen, soften, engrave, gamma correction, halftone, jiggle, mosaic, oil paint, polar,
spray, wave, and other effects). Very cool!

. Ability to resize multiple images at once MEW!
With this new feature, you can convert and resize multiple images all at once. This feature is very
useful if you want to create thumbnail images for your web page.



¢ Powerful files management capability
Combined with list box feature and drag'n drop support, Multimedia Manager is a powerful and reliable
file manager to manage your files. Moreover, you may select files with filters to select multiple files at
once.

e List box to ease you managing files Hem
With this unique feature, you can select files from many directories and then you can copy or
move those files at once.

¢ You can create collection of favorite files

¢ REAL drag and drop support HGT,
You can drag and drop files FROM Multimedia Manager TO Explorer, or vice versal!

e You can drop any image, audio/video clip, or cursor file supported by Multimedia Manager to the
display window to open it quickly

¢ Auto skip feature
With this feature you can view an image file and quickly load the next/previous image file in the current
directory skipping other files with different type. Very handy.

e REAL Explorer support
You can run Explorer to explore any folder by right clicking the folder and select Explore Folder..

e Bookmark feature to mark your most used directories



System Requirements

To run Multimedia Manager properly, your system should have:

« Intel 80486 or Pentium compatible processor for faster image processing
Microsoft Windows 95 or newer

VGA card

Sound card (if you want to play audio file)

Properly installed MCI drivers to play MOV, MPG and DAT files
Keyboard and mouse (highly recommended)

Important Note

Multimedia Manager will still run even in 16 or 256 color mode and can still display true color images
(with color reduction technique). If you want best image quality in 16 or 256 color mode, use image
dithering (need more loading time) in the Image Options menu.

If you want faster viewing and best image quality, use 16 bit or true color mode. Use 800 x 600 display
resolution for best result, because | design this software in 800 x 600 display resolution.



Installation

Normally, Multimedia Manager is distributed in a self-extracting ZIP file contains executable files, help file,
DLL and Setup program, so you just need to run the file and it will run the Setup program automatically.

If you are going to install the newer version, the SETUP program will check the current version and
prompt you to upgrade it to the latest version without erasing program configuration.

NOTE: If you download Multimedia Manager from Simtel.Net, it is packed in a ZIP file rather than a self-
extracting archive, so you need to unzip it first using PKUnzip or WinZip, then run the Setup program.



Getting Started

Here is Multimedia Manager's main window. Click on the picture to learn more.
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If you want to learn more about managing files, click below:

Working with files
Using list box to manage files

Or if you want to know how Multimedia Manager handles multimedia file, click below:

Viewing image file
Playing audio or video file
Viewing cursor file




Files filter

You can display only certain files you want to manage in the file list box.
Example, you want to display BMP files only. Select Change Filter in the View menu and type *.BMP in
the filter box then press OK button. After that, only BMP files will be displayed in the file list box.

Customize Filter |

Filker
|*.M|D,-*.WM;*.HM|
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File list box

File list box lists files in the active directory. Here you can view image, cursor, audio and video files.
You can change the files filter by selecting Change Filter from the View menu. To manage your files
quickly, press your right mouse button to access pop-up menu.



Path combo box

Use this to change active drive or directory. Press this button

The picture “Uplivl.bmp" iz mizzing!

to change to previous level directory



Toolbar
Here you can perform quick access to change directory, refresh directory, set files filter, create new
folder, copy files, and other common tasks.



Working with files

Quick step by step procedures to manage files:

e Change to directory where you will manage your files and set files filter if you want

» Select files (by holding <Shift> key while moving arrow keys or holding <Ctrl> and left click to select
multiple files at once)

¢ Drag them to the list box under file list box (or press <Insert>)

¢ Click E in the list box toolbar and select the action that you want to do on those files (copy, move,
delete, batch conversion, slide show, etc).

Tips:

¢ You can drag and drop files from Multimedia Manager to Explorer or vice versa

¢ Use bookmark to switch between directories quickly

¢ Use Tool - MS-DOS Prompt to go to DOS prompt if you want to format disk or check disk free space
¢ You can open more than one instance of Multimedia Manager if you like to.

To learn more advanced tips, click below:
Using list box to manage files

Using filters to select files

Using bookmark

Keyboard Shortcuts



File status
You can see the selected file status: its path and type.



Main menu
This is Multimedia Manager's main menu. Just click the menu title or press <Alt> and the underlined
character from the menu title you want to open.



Status bar
Here you can see the number of selected files in the file list box and their size. Also, if you open an
image file, the image information will be displayed under the display window.



Display window
Display window is place where image will be displayed to. Here you can scroll the image by dragging
your mouse and you can also access image pop-up menu by right clicking your mouse.



List box
The list box can be used to ease you managing files, especially if want to manage lot of files in many

directories. On the left side is the list box toolbar to provide quick access to manage the list box
contents. See also: What is list box?




Converting and saving images

Multimedia Manager can save image and convert multiple images to BMP, JPG, GIF, PNG, PCX, TIF
and TGA with various options.
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As you can see above, you can configure the conversion settings:

« save resolution (monochrome, 16 color, 256 color, 16 system color, true color or JPEG grayscale
¢ save quality and smoothing value for JPEG

¢ TIFF compression method (None, CCITT, FAXCCITT3, FAXCCITT4, LZW or PACKBITS)

e save as interlaced PNG

Multimedia Manager will use color reduction with dithering if the source image has higher resolution
than the target image, to keep the image quality.

[ e You can also resize multiple images at once by checking the Resize Image checkbox. This is
useful if you want to create thumbnail images for your web page.

NOTE

Some image formats cannot be saved in true color or 16/256 color resolution.

Example: GIF format only supports 16 or 256 color and JPEG format only supports true color or
grayscale.



Configuring desktop wallpaper
With Multimedia Manager you can configure your desktop wallpaper easily.

Change Desktop Wallpaper |
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Select the wallpaper position you want (tile, center, fit to screen or even at any position).
Moreover, you may use not only bitmap file for your wallpaper but also JPG, GIF, PNG, PCX, TIF or
TGA file. Multimedia Manager will handle the conversion problem for you.

NOTE
To fit your wallpaper to screen, you need Microsoft Plus installed in your system.
If you set Origin X or Origin Y to 0 then your wallpaper will be centered vertically / horizontally.



Using list box to manage files
What is list box?

Click on the picture for more help
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What is list box?

List box is like a shopping basket you use while shopping in supermarket. You can put anything you
want to buy there. In Multimedia Manager, list box is used to hold files that you have already selected in
the file list box. Those files in the list box can be copied, moved, deleted, or displayed as slide show.
The list box contents can be also saved as collection file.

This list box feature might be a new and unique concept for you, but if you have tried it, you may found
it very powerful and helpful in managing files, especially if you want to work on lot of files in many
directories.



Using list box pop-up menu

Copy
Mowve

Delete

Convert Images
Slide Show

Bemowve From List Box
Clear List Box

Files

Show Toolbar (Left)

Copy
Move
Delete

Convert Images

Slide Show
Remove From List Box
Clear List Box

Files

Show Toolbar

copy all files in list box
move all files in list box
delete all files inthe list box

convert all image files in list box (use this to batch convert mulltiple
images)

View all images in list box as slide show

remove selected files from list box

remove all files from list box

with this commands, you can create collection file

Save To File save list box contents to collection file
Load From File load list box contents from collection file

Append From File append list box contents from collection file

change list box's toolbar position (left, right or invisible)



Using filters to select files
You may select or deselect files with filters to ease you managing certain files.

Select Files |

Select files matched with

Ackion————————
% Select files

= Deselect files

k. Cancel

You can specify multiple filters separated by a colon (,) or semicolon (;).
Example: *.GIF, *.BMP; MUSIC*.MID



Copying/moving files

Copy Files |

E nter target direchany
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You can copy/move files to any folder by using this dialog. You can enter the target folder in four ways:
type it directly at the edit box, pick one from history list, press the {button ...,} button or pick one from
bookmark list. If the directory doesn't exist, you will be prompted to create it automatically.



Viewing image file

Multimedia Manager will load an image file and display it in the display window automatically if the 'Auto
open file' item in Options - General menu is checked. Otherwise you must press <Enter> or double click
the file to load and display it in the display window.

Supported formats are: BMP, JPG, GIF (including animated GIF), TIF, TGA, PNG, PCX, WMF, PCD,
and ICO.

After the image displayed in display window you can also access the image pop-up menu by clicking
the image with your right mouse button.

Beload
MNext Image
Previous Imaqge

Save As .
Close File

Stretch Image

Tile Image

v Center Image
Advanced J
Zoom [

Zoom Area
Eull Screen

Options

Here you can do anything you want like stretching, tiling, centering, saving, resizing or zooming the
image.

Set As Deskiop Wallpaper

Elip Image
Rotate 90 degrees

Increase Brightness
Reduce Brightness

More Effects _ . _

Print Image

Scan Image
Select Scanner

With this advanced popup, you can set the image as desktop wallpaper, filip or rotate image, increase
or decrease image brightness, print or scan image. Select Filters And Effects’ to add more filters and
special effects.

NOTE



If you use 16 or 256 color mode and want to view a true color image with best quality, just turn on the
'Dither image' item in the Options - Image menu.

See also:
Manipulate image



Manipulate image

This is one of the iom features in Multimedia Manager. To use it, right click on the image and select
Advanced - More Effects. The Effects Manager will be displayed to help you.
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You can select the kind of effects you like from the tab sheet (bleed, blur, border fade, blur, dark, curl
page, engrave, gamma correction, halftone, jiggle, mosaic, oil paint, polar, spray, wave, ...).

Toolbar Command

Hide Selection hide the rubberband

Reset Selection reset the rubberband to full image
Reload reload image

Preview preview this effect before applying it
Apply apply the effect to master image
Stop stop processing the image

Close and Save apply the effects to master image



Playing audio or video file

Just like viewing image file, you may also play audio (MID, WAV, RMI) and video (AVI, MOV, MPG,
DAT) file. To play MOV, MPG and DAT file require properly installed MCI drivers in your system.
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Use this media player panel to control playback of played file.

NOTE: For best result, | suggest you to use your default MPEG player (e.g. XingMPEG Player)
rather than Multimedia Manager to play MPG or DAT file.



Track bar
You can change the position of current played media here.



Playback control
Here you can play, pause, rewind, or step the played media.



Load previous file
Click this button to load previous file with same type.
Example: if you were playing an audio file, clicking this button will load previous audio file in current

directory.



Viewing cursor file

You can view cursor file (CUR or ANI) by selecting one and see your mouse pointer changes.



Load next file
Click this button to load next file with same type.
Example: if you were playing an audio file, clicking this button will load next audio file in current directory.



Media status
Here you can see opened media status and also the position and the length of opened media.



Click here to configure audio/video options.



Using bookmark

Bookmark feature is one of my favorite features in Multimedia Manager. It is just like bookmarks in
Netscape or Internet Explorer. With this you can switch between directories quickly.

Press <Ctrl+D> to add current directory to bookmark list and press <Ctrl+B> to list and manage your
bookmarks (just like in Netscape Navigator).

Nine last used bookmarks will be saved in Bookmark menu so you can jump quickly to a bookmark by
selecting it in the Bookmark menu.



Keyboard Shortcuts

Special Shortcuts (can be used while browsing files in the file list box)

Hold <Shift> or <Ctrl> while pressing arrow keys to select multiple files

Ctrl + Space deselect current file

Insert add selected files to list box

Ctrl + Insert remove selected files from list box if exist

Enter open selected file with default associated program or change directory if it is a folder
Backspace back to previous level directory

Shift + Delete delete selected files without sending them to recycle bin

You can also use your mouse to drag files from file list box and drop it into the list box, or vice versa.

Special Shortcuts (can be used while browsing files in the list box)
Hold <Shift> or <Ctrl> while pressing arrow keys to select multiple files in the list box

Delete remove selected files from list box

Another HOT Shortcuts

Press <Alt> and arrow keys (Up, Down, Left or Right) to load next / previous file with same type.
If you are viewing an image, than pressing <Alt> + <down arrow> will search next image file in current
directory, skipping other files.

Ctrl+Z clear list box contents

Ctrl + F8 copy all files in list box

Ctrl + F7 move all files in list box

Ctrl + Delete delete all files in list box

Ctrl + F6 convert all image files in list box
Ctrl+ P play / pause selected file (for audio/video file)
Ctrl +Y show / hide player panel

Ctrl +V save image

Ctrl +H stretch image

Ctrl+T tile image

Ctrl +R center image

F4 view image in full screen

Plus key (+) zoom in image

Minus key (-) zoom out image

Multiply key (*) reload image
Ctrl + Plus key increase image brightness
Ctrl + Minus key reduce image brightness

Files Shortcuts

Ctrl + N create new folder
Ctrl + X close file



F3 change directory

F8 copy selected files (in file list box)

F7 move selected files

Delete delete selected files

F6 convert selected files

F2 rename file

F9 open selected file with default associated program

Edit Shortcuts

Ctrl+C copy image to clipboard

Ctrl +A select all files

Ctrl +S select files with filters

Ctrl + 1 invert selection

View Shortcuts

F5 refresh directory

Ctri+ F change files filter

Ctrl+ O configure program options
Bookmark Shortcuts

Ctrl+D add current directory to bookmark
Ctrl + B list all bookmarks and select a bookmark to go to

Tools Shortcuts

Ctrl+ E run Windows Explorer
Ctrl+ W configure desktop wallpaper
Ctrl + L run slide show on images in current directory

Ctrl+ M go to MS-DOS prompt



Drag and drop support

These are some examples how to use the drag and drop support in Multimedia Manager:

¢ You can drag and drop file from any window (Explorer, desktop, etc) to Multimedia Manager's icon on
the desktop. If the file format is supported, the file will be opened automatically.

¢ You can drag and drop files from Multimedia Manager to any window (Explorer, desktop, etc). E.g. if you
drag and drop files from Multimedia Manager to another folder in Windows Explorer, this will copy the
files to that folder.

¢ Also, you may drag and drop files from any window to Multimedia Manager. The result depends on the
drop target. If the drop target is Multimedia Manager's display window, the file will be opened quickly. If
the drop target is Multimedia Manager's file list box, the files will be copied (also depends on the folder
where you drop the files). Or, if you drop the files to Multimedia Manager's list box, the files will be
added to the list box.

Tips: you can also drag and drop file from the list box to the display window if you want open it quickly.



Why should | register?

Multimedia Manager is distributed as shareware. It means you can try it before you buy. It never
expires, so you can distributed the unregistered version freely to your friend. See license agreement for
details.

Registration shows respect for the love and labor shareware authors put into their wares.

Please keep me going and honor the licensing agreements and register Multimedia Manager if it is
valuable to you! Last, but not least, you will have really useful benefits if you decide to spend the few
bucks - check it out.

| think the registration fee (US $25 for single user license) is very reasonable and affordable. By
registering your copy, you have supported and encouraged me to develop this software much more
better. See future development plans for details.

Registration Benefits

e FREE minor and major upgrades for lifetime (available on my web site)

¢ Your name will be displayed in the About box forever

You can convert and save as many images as you want to all formats supported by Multimedia
Manager

You can also edit and save any image you want as well.

Free technical support via e-mail

Announcement for new version or updates (via e-mail)

A good feeling that you are honest

See also:
How to register?




Shareware

The essence of shareware is to provide you with software that you get to "try before you buy", while
rewarding the efforts of the developers. When you think about it, the opportunity to try before you buy is
the ultimate guarantee of a product's quality and usefulness to you. In fact, shareware can be just as
professionally developed as software that comes in a fancy box (with a lot of hype and yet no way to
determine issues such as the "look and feel", etc.), but the price of shareware is often lower because it
does not have to cover expensive marketing costs. Still, software businesses that market their products
as shareware need to get paid for their efforts just as any other business. When you support the
shareware concept, it ensures that the concept will continue to work and you will continue to get to "try
before you buy". Thank you for understanding and honoring the "shareware" concept which can
ultimately benefit us all.



Unregistered Version

Select About in the Help menu.to see your Multimedia Manager version. In the unregistered version,
you can try all features in Multimedia Manager (uncrippled). The only limitations are you cannot
convert/save more than five images and the manipulated image (using filters and effects) can't be
saved. This limitation is intended just to encourage you more to register your copy. | apologize for any
inconvenience it causes.



After getting registration information

After registering, the registration information will be sent to you immediately (via e-mail). You can open the
About box and press "Enter Registration Number" button. You must enter your name and registration
number EXACTLY the way they appear in the letter. If your data were entered correctly, your name will be
displayed in the About box. You are now the lawful owner of the program.

Your registration includes FREE major and minor upgrades for lifetime. | will inform you as soon as they
are available, so you can download them from my web site.

NOTE

Be sure to save the registration information you received in a safe place. You will need it again if
you reinstall the program. Better safe than sorry. Also don't give your registration information to
others. Please review License Agreement for details.



How to register?

See also: Why should | register?
After registering

Pricing
Credit Card Order
Direct Order

Processing Delay Time

Pricing

Single user license US $25
Site license US $300
World-wide license US $1000
Educational license us $100

Latest version on disk add US $10

Prices are guarantied until April 1, 1998
These prices include FREE major and minor upgrades (available on my web site)

Site license covers a single organisation for an area of up to one hundred miles (160 km) in radius. If
you buy site license, you may use this software in unlimited number of computers of your company
within this area.

Wold-wide license covers all computers of single organisation world-wide.

Educational license is the same as site license but for educational institutions only (schools,
universities, etc).

NOTE: All types of licenses contain one registration number. If you want to purchase multiple single
user licenses, you may contact me for discounts.

Credit Card Order

Click here to go to my registration page

Credit card orders are handled for me by PsL (Public software Library).PsL is a service that handles
credit card orders for shareware programmers. Of course, this is not a free service. But the above
prices have already included the order processing fee.

If you place your credit card order now, as a bonus, you can save 80% on the latest PsL Shareware
CD-ROM with thousands of the latest freeware and shareware programs for home and office. The CD-
ROM normally sells for $30 plus shipping, but when ordering Multimedia Manager, you can get it for just
$6 plus shipping with a full money-back satisfaction guarantee.

The best way to place your order, is to use PsL's secure registration page on the web. You can find the
link on my registration page at http://members.xoom.com/twrs/register.html

Alternatively, you can contact PsL by



phone: 713-524-6394 Ext. 15509

fax: 713-524-6398 (ask for item 15509, please type or print, no handwriting)
e-mail: 15509@pslweb.com

voice orders: 800-242-4775 Ext.15509 (or "800-2424-PSL")

snail-mail: PsL, P.O.Box 35705, Houston, TX 77235-5705 USA

Note that the above numbers are for placing credit card orders only. If you have any problems, questions,
complaints, after placing your order (e.g.: you have not received the registration number yet), please do
not contact PsL but contact me, the author, directly at edy bd@yahoo.com.

When placing your order, please mention the following details:

¢ What you wish to register: Multimedia Manager, PsL product ID: 15509

Your name

Your postal address

Your e-mail address (registration number is sent to this address)

Credit card type and number, expiration date and the name on the card if it differs from your name

mentioned above.

¢ The name Multimedia Manager has to be registered to (usually the name of your company or your own
name).

Direct Order

You can also send your order directly to me by check or bank draft. Payment must be in US dollars
drawn on an international bank, or you can send international postal money orders in US dollars.

Mail your registration form to this address:
Edy Budiman

JI. Anggrek no. 33 B

Jakarta 10450

INDONESIA

Indonesian users can also directly transfer the money to my bank account. Contact me for my bank
account number.

The last option is to send me the registration form and include the registration fee ($25) in cash. But this

is entirely at your own risk.

Processing Delay Time

If you use PsL service, | will send you the registration code immediately after | get informed form PsL
that you have registered. | will do my best to ensure you get the code as soon as possible.

If you send your order directly to me via postal mail, then after | have received your order form and
payment, | will send you the registration code via e-mail.



Registration Form (for non-credit card orders)

Send this form t
Edy Budiman

J1l. Anggrek no.
Jakarta 10450
INDONESIA

Name :

o:

33 B

Company:

Address:

E-mail:

(your registration code will be sent to your e-mail address,

so please give the correct e-mail address)

Web site:

Enter name to register Multimedia Manager to:
(usually your company Or your name)

Registration det

ails

Register
Register
Register
Register

— — —
[

[ ] Send the

Total payment =

Payment method

[ ] Cash

Multimedia
Multimedia
Multimedia
Multimedia

Manager
Manager
Manager
Manager

(single user license)
(site license)

(world-wide license)
(educational license)

latest version on floppy disk

$25
$300
$1000
$100

$10

[ ] Check/bank draft/international postal money order in US dollars
[ ] Direct deposit

Others

[ 1] Inform me for updates and latest version

(via e-mail)



How did you hear about Multimedia Manager:

Comments and suggestions about Multimedia Manager:

I understand the license terms completely.

I understand that I will receive my registration number through e-mail and I
understand that only one person may use the software.

I understand that improper payment will not be returned.

Date:

Signature:



License Agreement

Multimedia Manager
Copyright © 1997,1998 by Edy B.
All rights reserved.

You should carefully read the following terms and conditions before using this software. Unless you
have a different license agreement signed by the author, your use of this software indicates your
acceptance of this license agreement and warranty.

Distribution

Provided that you verify that you are distributing the evaluation / unregistered version (select About from
the Multimedia Manager's Help menu to check) you are hereby licensed to make as many copies of the
evaluation version of this software and documentation as you wish; give exact copies of the original
evaluation version to anyone; and distribute the evaluation version of the software and documentation
in its unmodified form via electronic means. There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, however
made; and from distributing the software and/or documentation with other products (commercial or
otherwise) without prior written permission.

If you want to put the evaluation version of this software on a freeware/shareware CD-ROM or other
compilation, please contact me before doing so, to be sure that you are not including old or incomplete
stuff in the compilation. | would also appreciate it if I'd get a free copy of the CD-ROM.

Registered Version

One registered copy of Multimedia Manager may either be used by a single person who uses the
software personally on one or more computers, or installed on a single workstation used
nonsimultaneously by multiple people, but not both.

You may access the registered version of Multimedia Manager through a network, provided that you
have obtained individual licenses for the software covering all workstations that will access the software
through the network. For instance, if eight different workstations will access Multimedia Manager on the
network, each workstation must have its own license, regardless of whether they use Multimedia
Manager at different times or concurrently. Site license can be obtained which covers each workstation
at one location.

You may not distribute the registered version to anyone else.

This software is provided 'as-is', without any express or implied warranty. In no event will the
author be held liable for any damages arising from the use of this software.

This software has been written with great care but | do not warrant that the software is error
free.

You may not attempt to reverse compile, modify, translate or disassemble the software in whole
or in part.



Known Issues

Video playback problem

¢ | found problem when trying to play MPG or DAT file on a PC with MPEG card MP2000. | haven't tested
it with other MPEG card. The solution is by turning off the 'Auto open DAT or MPG file' option in Options
- Audio/Video menu, so the program will not auto open DAT or MPG file.

¢ | suggest you to use default associated program instead (e.g. your default MPEG player or XingMPEG
player) to play MPG or DAT file.

« If you pause the movie and drag the player panel across the display window, the display will corrupt.
After the movie resumed, the display will be restored.

Confusing hint

« | realize this anomaly accidentally. If you see the hint on the status bar read 'Copy selected files'
(though you are not going to copy any file), don't be confused. It's just a false hint. | have checked my
code and tried to figure out this problem, but | ddin't find any answer. I'm sure that | have set all the hint
properties of the menus correctly. So, | guess this anomaly probably a bug in Delphi 3 or Windows 95!!
If you know the reason of this anomaly, please tell me. However, it's just a little problem that won't
disturb you much.

I will do my best to fixed those problems in the next version. | realize that this software may have bugs
somewhere, although | have tried my best to eliminate them. So, if you encounter problems or bugs,
please tell me and also send me your system configuration (VGA card type, display resolution, O/S
version, etc).



About the author

Hi! My name is Edy Budiman. | live in Jakarta, Indonesia. I'm 21 years old when writing Multimedia
Manager for the first time. | am studying Information Science and | will graduate very soon. | also work as
a part-time senior programmer for a property marketing agent. My main hobby is writing useful software to
make my life and others better and happier. | have been learning programming for seven years.
Multimedia Manager has been entirely created using Borland Delphi. Well, Delphi is my favorite
environment and | am really interested on any Delphi related stuff you may have and wanna share with
me.

| am expecting your comment and suggestion about this software, and also feel free to mail me if you
find any bugs or problems.

You can contact me by e-mail at:

edy bd@yahoo.com

or

edy@binus.ac.id (only if the first failed)

Visit my web site (Tropical Wares) to get the latest version:
http:/come.to/twrs

Or perhaps if you have some nice postcards, | would be very happy if you can send me one to my
postal address:

Edy Budiman

JI. Anggrek no. 33 B
Jakarta 10450
INDONESIA



My other software

If you like Multimedia Manager, | expect you to try my other software, WallMaster. This is the newest
software | just finished and already available to download at my web site.

WallMaster is a utility to help you getting full control of Windows desktop wallpaper. You can control the
position of the wallpaper (tile, center, fit to screen, auto fit or custom), program the wallpaper to change
automatically after a predetermined time period (e.g. every 30 minutes), and you may use all your favorite
images (JPG, GIF, PNG, PCX, TGA, PCD and ICO) as desktop wallpaper. This cool software is released
as postcardware, so you don't have to pay any money for it, just a nice postcard to me. So, don't hesitate
to download it.

Click here if you want to download it from my site now



Credits

First, | would like to give special thank you to these people whose components and codes | used in
building this software:

Amedeo Lanza

Angus Johnson

Brad Stowers

Markus Stephany

Martin Djernaes

Theodore Kleynhans

| sincerely want to thank you all users that have registered their copy ©
Thanks to all my friends that has been testing this software.

Big thanks also to people that maintain Delphi Super Pages, Torry's Delphi Pages and The Delphi Deli
that really help me getting tons of freeware components, samples, and tips for Delphi.

Also to Robert Vivrette that maintains UNDU (Unofficial Newsletter for Delphi Users), a valuable
resources for me to get lot of tips and inspiration.

If you need tips or valuable components for Delphi, don't hesitate to visit these sites first:

http://sunsite.icm.edu.pl/delphi/  (Delphi Super Pages)
http://carbohyd.siobc.ras.ru/torry/  (Torry's Delphi Pages)

http://www.intermid.com/delphi/  (Delphi Deli)
http://www.informant.com/undu/index.htm  (UNDU)

http://www.user.xpoint.at/r.fellner/ (The Delphi Box)
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Future Development

| am serious in developing Multimedia Manager to become much more powerful and useful. So | plan to
implement more features in the next version.

Some of them are:

¢ Ability to add special effects to image (** already added since version 1.2a)
e Faster image loading

Folder information (number of files, folder size, etc)

More formats to be supported (I plan to add MP3 support)

More list box features to manage files better

ZIP support

You tell me...

If you have other ideas or suggestions to enhance Multimedia Manager, please don't hesitate to inform
me.

And if you haven't registered your copy, please register soon. Your registration will support and
encourage me in developing the software.



Collection File
The collection file is used to store your favorite files so you can view or play them anytime you want. It

is like playlist in your CD player software. The file is saved in ASCII format (*.MCL) and you can modify
it easily to fit your need.



Jakarta is the capital of Indonesia. Indonesia lies between Malaysia and Australia in the south east Asia
on your world map. You can find Jakarta on the west side of Java island.



ImageLib from Skyline Tools
ImagelLib is the graphics tool of my choice. Its fast image decoding, best image quality, and advanced

tools are very impressive. My main reason to use this excellent tool is to ensure your satisfaction using
this software. | am not implementing some powerful features from ImageLib yet, but | will (must be in
the next version). For more information about ImageLib, point your browser to http://www.imagelib.com



Uninstall Multimedia Manager

Uninstallation is very easy because | wrote my own Setup program. Although | can't imagine the reason
that cause you want to uninstall this nice software, you can uninstall it easily by running the Setup
program again.

Click here to run Setup program



Preview window
In this window, you can preview the image you want to manipulate. You can select a region on the
image by resizing or dragging the rubberband.



Use this button to add selected files from the file list box to the list box.
Tips: You can also perform the same task by dragging the selected files from the file list box and drop
them on the list box.



Use this button to remove all selected files from the list box.
Tips: you can do this by dragging the selected files from the list box to the file list box.



Use this button to add all files from the file list box to the list box.



Use this button to remove all files from the list box (clear list box contents)
Tips: you can also do this by pressing Ctrl + Z.



Use this button to access list box pop-up menu to manage those files in the list box.



These are the files that you can copy, move, delete, batch convert or view as slide show



Associate File Types

If you want to utilize the DDE feature, you must associate certain file types with Multimedia Manager. You
may prefer to associate some image file types (JPG, GIF, etc), so then you can open them quickly from
Windows Explorer by double clicking the file name.

Select "Associate File Types" from Tools menu to do so.

Associate File Types |

Y'ou can agzociate certain file tpes with Multimedia Manager.
Press F1 for more information...

BMP
7 TP 7 Wi Select All
v GIF Ribdl
II; PNG r Dezelect All
v PCx
v TIF 0K
v TGA
v PCD Cancel

L | 3

[T Dpen file without changing directon
[+ Enable image editing fram shell conbest remnu
¥ Enable image printing frarm shel contest menu

If you enable the image editing and printing option, you can right click the file name from Windows
Explorer to display the shell context popup menu like this:

Display
Edit Image
Frint Image
&3 Add to Zip
&3 Add to Goldgate zip

Send To 2

Cut
Copy
Create Shortcut

Delete
Rename

Froperties
You can select "Display” to use Multimedia Manager to display the image. Or you can select "Edit Image"
or "Print Image" to edit or print the image quickly.







